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Sazetak

U ovom zavr$nom radu obuhvaden je pregled parfema kroz povijest, upotreba
raznovrsne ambalaZze za parfeme, vrste ambalaze, njezina svrha, boje koje se koriste u
dizajnu ambalaze, kako kartonske tako i staklenih bocica te utjecaj izgleda ambalaze na
kupca i njegovu odluku o kupnji proizvoda tj. parfema. Ambalaza ima veliku ulogu
prilikom kupovine i odabira pojedinog proizvoda i zato se posebna paznja posvecéuje
dizajnu ambalaze, koji utjeCe na prodaju parfema. Ambalaza nema samo vizualni utjeca;j
nego svojom funkcionalno$¢u brine o kvaliteti proizvoda tj. parfema, Cuva njegovu
kvalitetu, a sluzi i kao ukras. Izgled ambalaze je bitan faktor pri odabiru proizvoda i utjece
na odluku o kupnji proizvoda.

Boje koje se upotrebljavaju pri dizajnu ambalaze takoder su vazan ¢imbenik koji
utjeCe na kupca. Dizajn ambalaze mora predstavljati proizvod, a isto tako zainteresirati
kupca i navesti ga da kupi proizvod. Svaka boja ima svoje znaCenje i svaku boju
povezujemo s neCim, takoder svaku boju ne moZemo koristiti u svakoj situaciji. S
psiholoSke strane, odredene boje na nas djeluju na razli¢ite nacine, ali povezanost s
bojama ocituje se 1 u tome da neki ljudi neke boje vole vise ili manje, dok neke boje uopce
ne vole. Moderna znanost pokusava odrediti kakva je veza izmedu boja koje volimo i
ljudskog ponasanja pa se razliCitim istrazivanjima uspjelo saznati da postoje veze izmedu
karaktera ljudi 1 osjeaja boja. Ambalaza 1 boje koje na prvi pogled privuku nasu paznju,
utjeCu na na$ odabir o kupnji proizvoda. U radu ¢u navesti i vrste parfema kao 1 10
najpoznatijih parfema koji su obiljezili parfemsku industriju. Na samom kraju rada

prikazat ¢u postupak izrade vlastite ambalaze i tijek same izrade.

Kljucne rije¢i: povijest parfema, ambalaza, vrste ambalaze, dizajn ambalaze, boje,

izrada ambalaze



Summary

This final paper includes the review of the perfumes throughout the history, use of various
packaging for the perfumes, types of packaging, its purpose, the colours used in packaging
design, both cardboard packaging and glass vials, and the impact of the package appearance
on the customer and his/her decision about the purchase of the product, i.e. the perfume. The
package plays and enormous role in the purchase and selection of a specific product, therefore
especial attention is given to the package design which impacts the sales of the perfumes. The
impact of the package is not only visual - its functionality preserves the quality of the product,
i.e. perfume, and it also serves as the decoration. The appearance of the package is an
important factor in selection of the product and impacts the decision about the product
purchase.

The colours used in the packaging design are also an important factor which influences the
customer. The package design has to represent the product, and also to intrigue the customer
and to entice him/her to buy the product. Every colour has its own meaning and can be related
to something. Also, each colour cannot be used in any situation. From the psychological
viewpoint, specific colours have various impact on people, but the relation with the colours is
manifested in the fact that people like some colours more or less, while some colours are
generally disliked. Modern science is trying to discern the connection between the colours
which are generally liked and human behaviour. Various researches have found out that there
are correlations between the person's character and the feeling of a specific colour. The
package and the colours which draw our attention immediately impact our decision about the
purchase of the product. In this paper, | will describe the types of the perfumes, as well as the
10 best known perfumes which have had the strongest impact on the perfume industry. In the
end of the paper I will show the procedure of the package manufacture and the process of the

manufacture.

Keywords: perfume history, packaging, types of packaging, packaging design, colors,
packaging design
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1. Uvod

Izrada parfema se moze slijediti kroz stare pisane spomenike sve do drevnih
civilizacija. Na hijeroglifskim zapisima se nalaze brojni prikazi prikupljanja mirisnih
materijala, pripremanja pripravaka i nacina njihove primjene. Mirisi su se nosili u kosi, na
tijelu, na odje¢i, i bili svima dostupni.

Dokumentirana povijest mirisa pocinje zajedno s pocetkom velikih drevnih
civilizacija, Egipéana, Rimljana, Zidova, Asira, Grka, Kineza - svi su oni na svoj nadin
upotrebljavali razli¢ite miriSljave tvari s razli¢itim ciljem. Egipani su mnoge mirisne
supstance smatrali vrijednijima od zlata, stoga su bile dostupne isklju¢ivo bogatima koji
su svoja tijela aromatizirali medom, cimetom i raznim cvjetnim mirisima. Oni su prvi
sadili 1 istrazivali mirisne biljke, te poceli sa stvaranjem aromatiziranih ulja 1 proSirili
njihovu primjenu izvan religijskih obreda. Carice su sadile botanic¢ke vrtove ¢iji je cilj bio
iskljucivo proizvodnja razli¢itih mirisnih pripravaka. U Perziji su vrtove bogatasa
ukraSavali cvjetovi jasmina, ljubi€ica, te crvenih ruza. Pupoljci crvenih ruza su se ¢uvali u
zatvorenim zemljanim posudama kako bi im miris postao $to intenzivniji nakon $to se
latice osuSe. U posebnim prilikama, posude su se otvarale kako bi se naglasila vaznost
nekog dogadaja. (1)

Utjecaj ambalaze na odabir proizvoda pri kupovini je od velike vaznosti. Na prodaju
nekog proizvoda utjeCe mnogo faktora, ali svakako je jedan od njih i ambalaza samog
proizvoda ili njegovo pakiranje. Dizajn i1 vrsta ambalaze proizvoda su vrlo bitni, jer
promjene kod ambalaZze mogu znatno utjecati na prodaju. Ambalaza treba sadrzavati
funkcije 1 osobine da svojim dizajnom 1 originalnos¢u privuku kupce. Proizvod treba
odgovarati ambalazi jer prenosi poruku koju proizvodac zeli predstaviti kupcu, pokrece
osjetila kupca prilikom kupovine do¢aravaju¢i mu sliku proizvoda.

U danasnjem modernom dobu svaki proizvod na trziStu opstaje samo uz dobro
osmisljenu i dizajniranu ambalazu. Kakav god proizvod bio, ambalaza ima zadatak Cuvati
proizvod, predstavljati njegove karakteristike, odrZavati kvalitetu i privlaciti paZnju
svojim izgledom.

Rije¢ ambalaza potjece od francuske rije¢i amballage, Sto znaci pakiranje, opremanje
robe, pribor za pakiranje, materijal za pakiranje i slicno. Ambalaza je sredstvo koje
priprema proizvod od trenutka proizvodnje do potrosnje za njegovo urucenje kupcu,

onakvog kakav je proizveden, u razli¢itim uvjetima transporta, skladiStenja, rukovanja,



distribucije, prezentacije na mjestu prodaje, tako da proizvod u ambalazi bude dobro

ocuvan od svih vanjskih i unutarnjih utjecaja.



2. Povijest parfema

Rije¢ parfem dolazi od latinske fraze, per, $to znaci kroz i fumus, $to znacéi dim.
Francuzi su kasnije dali ime parfem, ugodnom mirisu koji se Sirio okolo. Povijest parfema
Cesto se isprepli¢e s povijeséu ljudskog roda.

Prvi oblik parfema bio je tamjan. Tamjan su prvi otkrili u Mezopotamiji prije 4.000
godina. Drevne kulture palile su mnoge mirise za svoje vjerske obrede. Oni su cesto
mirise utrljavali u tijela zajedno s teku¢inom. Isto tako su sa parfemima balzamirali mrtve.

Nosenje prirodnih parfema se moze Ciniti modernim trendom, no takvi su mirisni
pripravci tijekom velikog dijela povijesti bili jedina moguénost. Napravljeni od raznih
materijala dostupnih u prirodi, vrlo ¢esto su imali viSestruku primjenu: koriSteni su kao
lijekovi, kozmeticki pripravci, parfemi, te kao sredstva za mirisno oplemenjivanje prostora

u ku¢ama ili prilikom javnih ceremonija 1 vjerskih obreda.

Najraniji parfemi su imali oblik mirisnih ulja i pomada. Proces dobivanja alkohola je
savladan mnogo kasnije, pa su se tek nakon toga parfemi mogli poceti proizvoditi u danas
najcesce koristenom, alkoholnom obliku.

Ljudi od davnina koriste parfeme. Smatra se da je primitivna izrada parfema zapocela
paljenjem biljnih smola kako bi se dobio kad koji se koristio u vjerskim obredima.

Do pocetka egipatskog Zlatnog doba, parfemi su koristili samo za bogove ili faraone.
Parfem je bio posStovan u biblijsko vrijeme i ¢esto se spominje miris u Bibliji. U Novom
zavjetu, tri mudraca su nosila darove zlata, tamjana i smirne Isusu.

Tamjan je vjerojatno jo$ uvijek najpoznatija biljka. Paljenje tamjana je bila privilegija
svecenika u najranijim civilizacijama. Obiaj je jo§ uvijek u uporabi i danas u nekim
crkvama. Tamjan i mirisna ulja polako postaju dostupna svim Egipéanima i postupno
napustaju ekskluzivna prava svecenika. Gradanima je naredeno da nanose parfem barem
jednom tjedno. Egipcani su, drze¢i do osobne higijene, razradili kupke, koje su bile
preteCe luksuznim kupaliStima Grka i1 Rimljana. Oni su natapali koZu uljima, jer im je to
koju su prakticirali i po tri puta dnevno.

Egipc¢ani su voljeli upotrebu parfema od rodenja do smrti. Mnogi Egipc¢ani su stavljali
parfeme u svoje grobnice kako bi zadrzali svilenkasto glatku koZzu u zagrobnom Zivotu. U
grobnice su stavljali urne optocene zlatom, staklenke i delikatnu keramiku ispunjenu

mirisima.



Jedan od prvih zapisa o upotrebi parfema potjeCe iz Egipta. Kad je otvorena grobnica
faraona Tutankamona, u njoj je pronadeno preko 3 000 bocica s parfemima, ¢iji se miris
nije posve izgubio ni nakon vise od 3 000 godina. (2)

Babilonski su gradevinari pri gradnji hramova u materijale dodavali mirisna ulja. Znali
su da ¢e tim postupkom na mjestima okupljanja mnogo ljudi dezinficirati zrak, ali isto
tako da ¢e mirisima djelovati na emocije i raspolozenje vjernika.

Grei su ucili od Egipéana. Obilno su koristili mirisne pripravke u brojnim
svakodnevnim situacijama. Rimljani su, ugledaju¢i se takoder na EgipCane, razvili
uspjeSnu parfumerijsku industriju. Oni su bili jo§ rastro$niji od Grka. Mirisnim su
pripravcima aromatizirali tijelo, kosu, odjecu, postelje, zidove svojih domova, pa ¢ak 1
zastave kad bi kretali u osvajacke pohode.

Potro$nja parfema je tada dosegla svoj vrhunac. Ducani s parfemima su bili popularna
mjesta susreta, a svakodnevna kupka vazna djelatnost grc¢kih drzavljana. RazliCite vrste
mirisa Kkoristile su se za pojedine dijelove tijela. Grcima se pripisuje umjetnost izrade
prvog tekuceg parfema, iako je bio prilicno drugaciji od parfema kojeg poznajemo danas.
Njihovi parfemi su bili mirisni prah pomijesan s teskim uljima, bez dodatka alkohola.
Tekucina se pohranjivala u izduzene boce od alabastera i zlata.

Drevni Grci i Rimljani naucili su o parfemima od Egip¢ana. Robna razmjena izmedu
Krete 1 Egipta je procvala. Najcjenjeniji cvijet na Kreti je bio ljiljan. Koriste¢i razne
mirise, maslinovo i bademovo ulje, dodavali su eteri¢na ulja ljiljana, ruze, anisa i korijena
perunike.

Rimske javne kupelji su bile posebne, a kupke cara Karakale su medu poznatijima.
Jedna soba, pod nazivom unctuarium, imala je police sa staklenkama mirisnih ulja i
esencija u bocama razli¢itih velicina. Rimljani su ¢ak iSli tako daleko da su parfeme
nanosili na pse i konje. Na sveCanostima, ptice pustene iz kaveza imale su namirisana
krila. (3)

Uz Aleksandra Velikog 1 invaziju na Egipat u 3. stoljecu prije Krista, koriStenje
parfema i1 tamjana je postalo raSireno u Grckoj. U Ateni su raspravljali o razli¢itim
mirisima, eteriénim uljima 1 podrijetlu biljaka, pa €ak i utjecaju razliCitih mirisa na
raspolozenje 1 razmiSljanje. Oni su takoder istraZivali povezanost izmedu percepcije

mirisa i okusa.

Poznata vladarica Egipta Kleopatra, bila je dobro upuéena u mo¢ mirisa i koristenje

parfema. Nakon atentata na Julija Cezara, ona je napustila Rim kako bi postala kraljica
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Egipta. Tamo je pozdravila Marka Antonija, rimskog politiara, na brodu s parfimiranim
jedrima. Kleopatrin dolazak su najavili oblaci parfema.

Fenicani su bili poznati trgovci mirisima. Posjedovanje mirisnog bilja bio je dokaz
bogatstva. Bilo je otmjeno nositi parfem, i vlasnici velikih koli¢ina mirisnih ulja bili su
postovani.

Poveznici proslosti i sadasnjosti parfema su Arapi. Proces vadenja ulja iz cvjetova
pomocu destilacije, (postupak koji se najcesce koristi i danas), je razvijen od strane
Avicena, arapskog lije¢nika koji je takoder bio 1 kemicar. On je prvi eksperimentirao s
ruzama. Do njegova otkri¢a, parfemi su bili mjeSavina ulja 1 bilja, ili latica Sto je davalo
snaZan spoj. Ruzina vodica je osjetljivija i odmah je postala popularna.

Za vrijeme vladavine Katarine de Medici u Francuskoj je procvjetala potroSnja
parfema. Katarina je imala svog izradivaca parfema, Rena le Florentina kojega je dovela
iz Italije. Njegov laboratorij je bio povezan s njezinim tajnim prolazom, tako da se nijedna
formula nije mogla ukrasti.

Parfem je ostvario ogroman uspjeh tijekom sedamnaestog stolje¢a. Namirisane
rukavice postale su popularne u Francuskoj. Parfem je doSao na svoje kada je Luj XV.
dosao na prijestolje u 18. stolje¢u. Njegov dvor su zvali mirisnim dvorom. Madame de
Pompadura narucila je ogromne zalihe parfema, a kralj Luj je svaki dan zahtijevao
drugaciji miris. Na dvoru Luja XV., parfem se nanosio na kozu, odje¢u i namjesta;j.
Parfemi su zamijenili sapun i vodu.

Nakon §to je Napoleon dosao na vlast, potro$nja parfema se nastavlja. Svaki tjedan su
mu dostavljali dvije litre kolonjske ljubi¢ice. Josephine je preferirala ja¢i parfem. Voljela
je mosus 1 toliko ga je koristila da se osjetio 1 Sezdeset godina nakon njezine smrti u
njenom boudoiru.

Parfem je svoj vrhunac u Engleskoj dosegao za vrijeme vladavine Henrika VIII. i
kraljice Elizabete I. Svi na javnim mjestima su morali biti namirisani jer kraljica Elizabeta
nije podnosila neugodan miris.

Kao i1 umjetnost, parfem prolazi kroz duboke promjene u devetnaestom stoljecu.
Nastali su novi mirisi. Francuska revolucija ni na koji nacin nije umanjila potroSnju

parfema, bilo je ¢ak i mirisa pod nazivom ,,Parfum a la Guillotine".

Na prijelazu stolje¢a, parfemi su imali cvjetnu notu. Ruze, ljubidice, jorgovan i durdice
su bile trazena roba. Cvjetni buket mirisa postaje popularan. Ovaj napredak je bio

revolucionaran u industriji parfema.



Grad Grasse u Provansi postaje najvece srediste za proizvodnju sirovina za parfeme.
Pariz postaje komercijalni pandan Grasse i svjetsko srediSte parfema. Parfemske kuce
poput Houbigant (proizvodi Quelques Fleurs), Lubin, Roger & Gallet i Guerlain imaju
svoja sjedista u Parizu. Uskoro punjenje postaje vaznije od sadrzaja. Proizvoda¢ parfema
Francois Coty ulazi u partnerstvo s Reneom Laliquelom. Lalique tada proizvodi boce za
Guerlain, D'Orsay, Lubin, Molinard, Roger & Gallet i druge.

Couturier Gabrielle Chanel 1921. pokrece vlastiti brand parfema, a Ernest Beaux
stvara vje¢ni Chanel No.5. Sve ostalo je povijest. Ime je dobio jer je bio peti u nizu mirisa
Ernest Beaux koji je prikazan slavnoj Coco. Ernest Beaux je prvi koristio aldehid u izradi

parfema. U stvari, Chanel No.5 je bio prvi potpuno sinteti¢ki miris za masovno trziste. (4)



3. Boje

Boja u svakodnevnom zivotu ima viSestruko znacenje, a svi pokusaji definiranja tog
fenomena rezultirali su nedore¢enim definicijama koje jo$ uvijek u potpunosti ne daju
jasnu sliku fenomena boje. Za umjetnike, boja je estetski pojam koji sluzi naglasavanju
kontrasta kao izraza dramati¢nosti. Za fizicare, boja je fenomen svjetla. No uza svu
nejasnost u definicijama vezanim uz pojam boje, jedno je jasno: ako boju mozemo
dozivjeti samo nasom vizualnom percepcijom, tada je boja iskljuc¢ivo subjektivni, opticki
fenomen pojedinog promatraca. Boju, dakle, ne mozemo opipati, nanjusiti, okusiti ili cuti,
a ipak ju osje¢amo svim svojim osjetilima, okruzeni smo njome, a ne znamo ju ni to¢no
definirati ni to¢no identificirati.

Proucavanjem boja 1 njihovog utjecaja na covjeka bavi se psihologija boja. Razli¢itim
istrazivanjima dokazano je da ljudi razli¢ito percipiraju boje. Neke od boja su vise
omiljene, a neke manje. Boje imaju svoja pozitivna i negativna znac¢enja. Zbog toga nije
svejedno koju boju ¢emo upotrijebiti u odredenoj situaciji. Ako zelimo utjecati na odluku
0 kupovini, pametno je upotrijebiti crvenu boju jer ona poti¢e na akciju i samim time
moze Utjecati na ponasanje potrosaca.

Boja je vrijedan alat i sastavni dio marketinske komunikacije koji Salje mo¢nu poruku
potroSacima. Svrha boje u marketin§koj komunikaciji je izazvati pozornost kod ljudi i
ostati im $to duZe u sjeCanju. Veoma je vazno znati kome je proizvod namijenjen.
Marketinski stru¢njaci su vrlo dobro upoznati sa psiholoskim utjecajem boja i njihovim
djelovanjem na nase podsvjesne mehanizme. Zbog toga marketinski stru¢njaci sluzeci se
bojama, njihovim pravilnim odabirom i kombiniranjem, navode nas na kupnju odredenog

proizvoda i samim time stvaraju utjecaj na potroSacko ponasanje. (5)

Slika 3.1 Boje



3.1. Crvena

Crvena je jedna od najintenzivnijih boja, temperamentna, boja vatre i krvi. Povezana je s
energijom, ratom, opasnosti, snagom, moc¢i i odluc¢nosti, kao i stras¢u, zeljom i ljubavi.
Odnosi se na strast, vatru, brzinu, nadmetanje. Ima veoma visoku vidljivost i zbog toga su
prometni znakovi, znakovi opasnosti kao i zaustavni stop znak, stop svijetla na automobilima,
I vatrogasna oprema, crvene boje.

Odli¢no se slaze sa naranCastom, smedom i zutom bojom. U dizajnu i umjetnosti crvena se
koristi kao boja za naglasavanje, da bi se na neSto stavio fokus i ostavio poseban dojam.
Tehnicki, crvena boja "iznosi" tekst 1 slike u prvi plan, ¢inec¢i da objekti izgledaju veci 1 blizi.

Crvena boja u dizajnu se Cesto koristi za poticanje korisnika da donesu odluku o kupnji.

3.2. Plava

Plava boja je boja mirnoce koju povezujemo s dubinom i stabilno$¢u. Simbolizira odanost,
povijerenje, mudrost, samopouzdanje, inteligenciju, vjeru, istinu i raj.

Asocira na nebo 1 more. Reflektira mir, harmoniju, povjerenje i sigurnost. Znacenja plave
boje su kreativnost, inteligencija, inspiracija, umjetnost, napredak, sigurnost, tehnologija,
sloboda, beskrajnost, utjeha, stabilnost.

Plava boja se odli¢no slaze sa ostalim pastelnim bojama. Jak utjecaj moZe biti stvoren
kombinacijom plave, crvene i zute. Ne slaze se sa narancastom.

Korporativnu plavu boju koriste velike kompanije, kao na primjer Microsoft, Facebook.
Odli¢no lezi stranicama firmi koji reklamiraju poslovne proizvode, tehnologiju, medicinske
proizvode, Cistocu, zrak, vodu, more i motorna vozila. Treba voditi racuna o tome da se

pretjeranom upotrebom plave boje u dizajnu ambalaze moze stvoriti dojam hladnoce.

3.3. Zuta

Zbog najvece refleksije od svih boja, zuta je prva boja koju ljudsko oko opaza. To je boja
sunca, svjetlosti i optimizma. Svojom intenzivnosti, prodornosti i bljestavosti stvara topli
efekt 1 poti¢e na radost. Njezino koriStenje u 10. stoljecu bilo je rezervirano za careve i
njegove odabranike.

Zuta je boja sundeve svjetlosti i ljeta. Potie optimizam, sreéu, idealizam i mastu.

ZnacCenja Zzute boje su zadovoljstvo, intelekt, ubrzano ucenje, memorija, suradnja,



organizacija, Cistoéa, entuzijazam, razumijevanje, radoznalost, Zelja za poboljSanjem, nada,
prosvjetljenost, energija.

Zuta je veoma efektivna kod privladenja paZnje, tako da se upotrebljava da istakne
najvaznije elemente dizajna ambalaze. Ako se upotrebljava svjetlo zuta u dizajnu, obi¢no joj
je potrebna tamna boja da je istakne.

Odlicno se kombinira sa plavom ili sivom. Za vatrenu kombinaciju, koristi se u

kombinaciji sa crvenom bojom.

3.4. Zelena

Najugodnija boja za gledanje je zelena, najvise odmara ljudsko oko. Simbolizira rast,
harmoniju, svjezinu 1 plodnost. Egipéanima je predstavljala boga vegetacije 1 smrti, Osirisa.
Ljudi koji vole zelenu boju su veseli i dobronamjerni te se lako prilagodavaju okolini. Neke
od vrlina koje ih krase su iskrenost, upornost i marljivost. Koristimo ju kod reklamiranja
proizvoda na prirodnoj bazi, proizvoda koji su zdravi i kod reklamiranja lijekova i
medicinskih proizvoda.

Zelena je najpopularnija boja za dekoraciju.

Sinonim je za zdravlje i prirodu. Stvara utisak opuStanja. Mnogi govornici pred bitne
nastupe sjede u zelenim sobama da se opuste. Zelena simbolizira svjezinu, hladnocu, razvoj,
bogatstvo, sigurnost, stabilnost...

U umijetnosti i dizajnu je veoma zahvalna. Jaka je i ostavlja snazan utisak. Cesto se koristi
u kombinaciji sa tamno plavim tonovima.

Zelena se upotrebljava u dizajnu da ukaze na sigurnost kada se reklamiraju lijekovi i ostali
medicinski proizvodi. Bolnice Cesto koriste zelenu boju. PoSto je povezana sa prirodom,
koristi se za reklamiranje zelenih, organskih i zdravih proizvoda.

Tamnija zelena je obi¢no povezana sa novcem, financijskim svijetom, bankarstvom i
nov¢anim uspjehom. U kombinaciji sa naran¢astom i zutom stvara utisak podoban za sportski

orijentirane proizvode.

3.5. Narancasta

Narancasta boja je boja vatre i sunca, intenziteta, snage i Zivota. Povezujemo ju sa
izlaskom i zalaskom sunca. Narancasta je topla boja koja proizvodi entuzijazam. MijeSanjem

crvene 1 zute dobivamo narancastu boju koja kod ljudi izaziva osjecaj topline asocirajuci nas



na vatru. Kombinira energiju crvene i srecu Zute boje. Cesto ju povezujemo s jeseni, hranom i
zacinima. Prihvacena je kod mlade populacije. Tamniji tonovi narancaste boje asociraju na
udobnost i zastitu. Ukoliko Zelimo naglasiti neke elemente, narancasta je idealna boja za to.
Koristi se za privla¢enje paznje i isticanje najvaznijih elemenata u dizajnu.

Ako zelite privuéi paznju prilikom izrade ambalaze, ona predstavlja pravi izbor. Odli¢no
se kombinira sa sivom i zelenom. Ne treba je koristiti sa plavom.

U dizajnu, narancasta je boja koja privlaci paznju i pruza osjecaj topline.

3.6. Ljubicasta

Mijesanjem plave i crvene, dobivamo ljubiCastu boju. Zbog najkrace valne duljine u
vidljivom dijelu spektra, Cesto se povezuje s mistinoS¢u 1 tajanstvenoScu. Tajanstvena,
misticna 1 pomalo neobi¢na boja koja simbolizira mo¢, plemstvo, luksuz, ambiciju te spaja
ekstravagantnost 1 bogatstvo. U povijesti je bila koriStena za prikazivanje boga Jupitera kod
Rimljana. Zahvaljujuéi kraljici Elizabeti i britanskom parlamentu, postala je modna senzacija
19. st. Mogu¢nost noSenja ljubicaste odjece imali su samo plemic¢i 1 bogatasi jer je bojanje
sintetike ljubiastom bojom bilo veoma skupocjeno. Leonardo da Vinci vjerovao je da
ljubicasta boja pospjeSuje meditaciju. Bila je jedna od omiljenih boja egipatske kraljice
Kleopatre. Kako bi dobila jednu uncu ljubiCaste boje, njezini robovi potapali su u vodi 20.
000 purpura puzeva deset dana.

Ljubicasta je boja fantastike, impulzivnosti i snova. Zenstvena je i romanti¢na.

Podrazumijeva luksuz i1 bogatstvo. Simbolizira uzvisenost, dostojanstvo, visok polozaj,
postovanje, otmjenost, profinjenost, kraljevstvo, mo¢, eleganciju, utjecaj, skriveno znanje,
ponos, visoke ambicije, plemenitost...

U umjetnosti i dizajnu, ljubicasta boja je veoma popularna.

Koristi se zajedno sa drugim pastelnim bojama, odnosno hladnim tonovima plave, zelene
pa cak i sive. Ljubicasta boja kombinira stabilnost plave i energiju crvene.

Poznato je da je ljubiCasta jedna od omiljenih boja Zena, pa samim tim moZe utjecati na

odabir pri kupniji.

10



3.7. Ruzicasta

Ruzicasta boja je jedna od njeznih boja, djelomi¢no crvena, a ipak blaga. To je boja
ljubavi 1 osjecajnosti. Prema tradiciji, smatramo ju zZenskom bojom i zbog toga je veéina
odjeée za djevojcice ruzicaste boje.

Ne ostavlja snazan dojam. Ljudi je vole, ili ne vole. Pomaze u izrazavanju osjecajnosti i

umanjuje osjecaj krivice.

3.8. Plavozelena

Plavozelena ili tirkizna je boja koja zraci svjeZinom 1 ¢istocom. Potice kreativnost 1 dobru
komunikaciju. Vole je ljudi koji ne vole plavu, a ni zelenu boju. Koristenje plavozelene u
velikim koli¢inama dovodi do bezosjecajnosti i poteSkoce u komunikaciji. Zbog smirujuceg i
osvjezavajuceg ucinka, preporucuje se za osobe koje velik dio radnog vremena provode za

racunalom. Ljudi koji vole plavozelenu su narcisoidni i samoljubivi, egocentricni i rafinirani.

3.9. Bijela

Bijela je posebna boja, koju neki i ne smatraju bojom. SavrSeno je uravnotezena,
predstavlja sve boje u jednoj. Simbol je Cistoce, istine, mira, dobrote, nevinosti i zastite. U isto
vrijeme oznacava sve 1 niSta. Koristimo je za naglaSavanje iskrenosti 1 jednostavnosti, za
dobrotvorne organizacije i medicinsku opremu. Ljudi koji vole bijelu boju su obi¢no mirniji
tipovi koji imaju snazne moralne nadzore. Krasi ih pedantnost i preciznost. U Kini i Japanu,
bijela je boja za sahrane, a u svijetu predstavlja simbol mira. Koristi se za isticanje sigurnosti
kod medicinskih proizvoda. Takoder se koristi kod reklamiranja niskokalori¢nih, nemasnih i
mlije¢nih proizvoda. Bijela je po definiciji spoj svih boja spektra i nije boja. Zbog toga je
najsvjetlija, vizualno najlaksa i vrlo prijatna.

Smatra se da je bijela boja, boja savrSenstva. Bijela boja znaci sigurnost, jednostavnost,
darezljivost, moralnost i ¢istocu.

Tehnicki, u dizajnu bijela boja naglasava druge boje.
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3.10. Siva

Siva je neutralna i uravnotezena boja nastala mijeSanjem bijele i crne. Ima asocijativnu, ali
ne i emocionalnu vrijednost, ne izaziva emocije. lako moze izgledati tmurno, ljuto i neosobno,
podsjeca nas na sigurnost i mudrost. Siva je boja metala, srebra i asocira nas na visoku
tehnologiju, industriju, intuiciju, Zenske snagu i komunikaciju. Kombinacijom sive s drugim
bojama stvaramo izgled visoke tehnologije Ako kombiniramo sivu i crvenu, mozemo dobiti
zanimljive efekte, a u kombinaciji s zlatnom 1 bijelom mozZe promovirati osje¢aj kontrole 1
mo¢i. Najbolju kombinaciju ostvarujemo kombiniranjem sive 1 naranCaste koje su
komplementarne i samim time dobivamo utisak ekskluzivnosti. U kombinaciji s jarkim
bojama daje odlicne rezultate. Neutralizira jarke boje 1 ublazava njihovu jacinu. Simbolika
sive boje: mudrost, zrelost, kompromis, monotonija, poslovnost, hladnoca, bezbojnost,
sigurnost, pouzdanost, inteligentnost, profesionalnost, prakti¢nost, kvaliteta, umjerenost i
neutralnost. Ljudi koji vole sivu boju su zreli, odgovorni, pouzdani i zreli. S druge strane ovu
boju preferiraju ljudi koji su zatvoreni i ograduju se od vanjskih utjecaja. Koristimo ju kao
boju zalosti 1 formalnosti.

Siva boja je neutralna boja.

U dizajnu, siva predstavlja ekskluzivnost. Vezuje se za kreativnost i inspiraciju.

Tehnicki, moze da se koristi kao podloga za elemente koje Zelimo istaci.

Kada se siva pomijeSa sa crvenom, naran¢astom ili zutom postaje "topla siva.” Kada se

pomijesa sa zelenom, plavom ili ljubiCastom postaje "hladna siva."

3.11. Crna

Crna boja je suprotna bijeloj 1 moze se poput bijele smjestiti na oba kraja kromatske
ljestvice, oznacavajuéi na jednom kraju granicu hladnih, a na drugom granicu toplih boja. Uz
crnu boju vezemo snagu, eleganciju, formalnost, smrt, zlo i1 tajanstvenost povezanu sa
strahom od nepoznatog. Crna boja na zastavama i grbovima te u mnogim kulturama
simbolizira zalovanje i smrt. Crna boja pruza osjec¢aj dubine 1 perspektive.

Crna je boja autoriteta i moci.

Znacenja crne boje su elegancija, formalnost, tajnovitost, dubina, dramati¢nost, ozbiljnost,
zagonetnost, misterij, bogatstvo, tuga, dostojanstvo, no¢, prestiz..

U dizajnu, crna ostavlja utisak profinjenosti, misterioznosti i elegancije.
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3.12. Smeda

Smeda boja je neutralna, topla boja, boja zemlje i djelatnosti vezanih uz zemlju. U prirodi
ju pronalazimo u Zzivim i nezivim organizmima. Simbol je ljubaznosti, postojanosti,
pouzdanosti i jednostavnosti. Ukoliko Zelimo prenijeti osjecaj topline, korisnosti i postenja,
koristimo smedu boju. Cesto se koristi za opisivanje neéega $to je ruzno. Zbog toga se u
pravilu smatra odbojnom bojom. Kombinacija smede i zelene stvara poseban par zemljanih
boja koje Cesto koristimo kod reciklaze. Smeda je boja koja se odnosi na komfor, stabilnost i
jednostavnost.

Znacenje smede boje su i1 drvo, zemlja, stabilnost, prijateljstvo, kuca, udobnost,
izdrZljivost, intimnost, spokoj, briga, zadovoljstvo, snaga, senzualnost, produktivnost,
prakticnost. Tehnicki, smeda boja je tamno Zuta, tamno crvena ili tamno narancasta boja.

SlaZe se sa zelenom, plavom, crvenom 1 naran¢astom bojom.

3.13. Srebrna

Srebrna boja Cesto oznacava visoku tehnologiju.

ZnaCenja srebrne boje su glamuroznost, izuzetnost, industrija, intuicija, snovi,
komunikacija, suvremenost...

Srebrna predstavlja bogatstvo. Najskuplje umjetnicko djelo do danas je kreirano u srebrnoj
boji. Skulptura lubanje izradena od dijamanata, autora Damiena Hirsta, je prodana za 99

milijuna dolara.

3.14. Zlatna

Zlatna boja predstavlja prestiz i bogatstvo. U povijesti, zlato je ¢esto simboliziralo boga i
bozanstva. Predstavlja prosvijetljenost, mudrost, bogatstvo, pobjedu, novac, mo¢, srecu,
smisao, nauku, ispunjenje, koncentraciju i visoku kvalitetu. Isto kao i siva, ni zlatna boja ne
moze se dobiti direktno iz palete boja, zato Sto sadrzi odsjaj.

U kombinaciji sa drugim bojama, zlatna odli¢no pristaje sa naranCastom, zelenom ili

smedom. Takoder, isto kao i Zuta ostavlja odli¢an dojam u kombinaciji sa crvenom ili

ljubicastom. (6) (7)
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4. Ambalaza i vrste ambalaze

Ambalaza je materijal unutar kojeg se smjeSta i pakira proizvod kako bi se zastitio,
transportirao, skladistio i u konacnici koristio od strane kupca. Opéenito govoreéi ambalaza je
materijal u koji se proizvod smjesta odnosno kojim se proizvod omotava. Ona proizvodu daje
identitet, te kupcu stvara prvi dojam i dozivljaj o samom proizvodu. Zbog toga ambalaza
namijenjena za kozmeti¢ke proizvode, samim tim i parfeme, tezi sve ve¢em unaprijedenju s
obzirom na zahtjeve koji se javljaju 1 koje kozmeticko trziSte namece. Najvecu ulogu u
odabiru nekog proizvoda predstavlja kvaliteta samog proizvoda, ali je vrlo vaZzan utjecaj
ambalaze. Cinjenica je kako je prvo $to kupca privuée izgled ambalaZe proizvoda, bocica ili
vanjsko pakiranje. (8)

Kvalitetu proizvoda ne mozemo znati prije isprobavanja istog, zbog toga se posebna
pozornost pridaje upravo ambalazi. Ona je jedan od razloga zbog ¢ega se odlu¢imo upravo za
taj proizvod, ali ambalaza ne jam¢i sigurnost da ¢emo se pri ponovnoj kupnji opet odluciti za
isti proizvod. 1z toga je vidljivo kako su kvaliteta i ambalaza dva vrlo vazna faktora koja ovise
jedan o drugome. Kako se kozmeticka industrija svakodnevno sve viSe i vise razvija, raste
potreba za stvaranjem novih materijala, oblika i tehnika koje moraju pratiti nove suvremene
trendove stvarajuc¢i nove pojedinacne stilove ovisno o vrsti ambalaze koja je namijenjena za
odredeni kozmeticki proizvod. Takoder je vazno napomenuti kako odabir materijala za izradu
ambalaze daje vrlo jasnu poruku o samom proizvodu. Buduc¢i da je kozmeticko trziste u
stalnom porastu sve vise se tezi postizanju visokokvalitetnog izgleda pri ¢emu treba obratiti

paznju na sve vanjske utjecaje i inovacije koje idu u korak s trendovima. (9)

4.1. Podjela ambalaze

Podjele ambalaze ima jako puno, a jedna od osnovnih podjela je na primarnu, sekundarnu
1 tercijarnu ambalazu. Jo§ jedna od vaZnijih podjela je prema vrsti ambalaznog materijala, te
prema trajnosti.

Osnovna podjela ambalaze na primarnu, sekundarnu i tercijarnu podrazumijeva podjelu
ambalaze prema osnovnoj funkciji u transportu robe. Spomenut ¢u samo primarnu jer je ona

vazna za utjecaj na odluku o kupnji proizvoda.
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4.1.1. Primarna ambalaza

Primarna ambalaza je ona u koju se pakira proizvod za prodaju, omogucava jednostavnu
uporabu proizvoda, Salje informaciju o proizvodu, S§titi proizvod, predstavlja ga svojim
izgledom, oblikom i materijalom. Kvaliteta primarne ambalaze pridonosi kvaliteti proizvoda i
kao takva je odgovorna za uspjeh na trziStu. Pod primarnom ambalazom smatraju se svi
dijelovi i oblici za zatvaranje i zastitu ambalaze. Konkretno kod parfemskih proizvoda

primarna ambalaza je oblik u koji je smjesSten parfem. (10)

4.2. Podjela ambalaZe prema vrsti ambalaznog materijala

Svojstva ambalaze ovise o izabranom materijalu za njenu izradu. Materijal odreduje oblik,
izgled, veli¢inu, pa i na¢in upotrebe ambalaze. Vrsta materijala od kojeg je ambalaza izradena
pridonosi vrijednosti proizvoda i utjeCe na cijenu kona¢nog proizvoda. Pri odabiru materijala
treba obratiti paznju na nekoliko ¢imbenika. Prvo treba odabrati materijal koji ne reagira sa
samim proizvodom i ne utjece na kvalitetu proizvoda, te ne prenosi lose sastojke u proizvod.
Potrebno je odabrati materijal koji neée poticati rast mikroorganizama kod proizvoda.
Obavezno je obratiti paznju na to kako se parfemi nanose direktno na kozu, stoga ambalaza u
kojoj se nalazi proizvod mora biti dermatoloski ispravna, netoksi¢na. Ovdje ¢u nabrojiti
materijale i njihove karakteristike koji se najée$¢e koriste pri proizvodnji ambalaze za

parfeme. (10)

4.2.1. Staklo

Jedan je od najstarijih ambalaznih materijala. Staklo je smjesa silikata s dodacima.
Njegova uporaba je vrlo ¢esta u proizvodnji bocica za parfeme. Prepoznatljivo je po svojoj
prozirnosti, sjaju i krutosti Sto se tie same strukture. Nepropusno je za plinove i tekucéine.
Koristi se za pakiranje parfema koji zahtijevaju luksuzniji izgled. Neke od dodatnih prednosti
stakla su $to je jeftino, ne mijenja oblik, odnosno ne iskrivljuje se, ne §iri se, ne mijenja
veli¢inu, ne blijedi, ekoloski je prihvatljivo jer ga je moguce ponovno Koristiti tj. moze se
reciklirati. Budu¢i da proizvodnja stakla zahtjeva veliku potroSnju energije pri prvoj
proizvodnji, ponovna prerada stakla smanjuje potrosnju. Jedni od glavnih nedostatka stakla su
tezina i lomljivost. No sigurno je kako ¢e staklo u proizvodnji parfema i dalje imati jednu od

vodec¢ih uloga Sto se tiCe materijala za izradu ambalaze upravo zbog svog ,,luksuznog*
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izgleda. Dizajner sa pravim izgledom bocice moze stvoriti vrhunski proizvod i ucini ga

privla¢nim kupcima. (11)

4.2.2. Polimeri

Poznatija pod nazivom ,,plastika“ je najmlada od svih vrsta ambalaze. Danas je najces¢a u
primjeni, a najceS¢e sluzi kao zamjena za staklo i metale. U nekim slu¢ajevima tesko ju je
zamijeniti nekim drugim materijalom. Plastika je skup razlicitih vrsta polimernih materijala.
Najveéu zastupljenost imaju plastomeri (termoplasti¢ni polimerni materijali), zatim slijede
duromeri (termoreaktivni polimerni materijali), pa elastomeri koje koristimo pri zatvaranju
ambalaZze radi postizanja hermeticnosti. Kako postoji veliki broj razli€itih polimernih
materijala moguce je proizvesti gotovo sve oblike ambalaze.

Polimerna ambalaza je izdrZljiva, lagana, otporna na vlagu i raspadanje, ¢ak su neke vrste
nepropusne za plinove. Lako ih je obradivati 1 oblikovati. Moguce ih je bojati 1 tako
doprinijeti drugacijem izgledu proizvoda. Danas plasticna ambalaza izgleda poput stakla. Ovu

ambalazu moguce je reciklirati. (10)

4.2.3. Biorazgradivi polimeri

Svakim danom industrija napreduje. Tako i industrija materijala za pakiranje teZi
otkrivanju i razvoju novih rjeSenja. Otkriveni su polimeri koji su skloni biorazgradivosti.
Takva ambalaza jo$ uvijek se teSko proizvesti iako se stalno nalaze nova rjesenja. Razvoj
trziSta ovakvih polimera zauzima ulogu skupljanja organskog otpada iz kucanstva koji ¢e se
kompostirati na odlagalistima i kasnije u industrijama preradivati i koristiti za izradu
biorazgradive ambalaze. Razvoj ove vrsta materijala jo§ je jedan korak vise i na podruéju
ekologije. (11)
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4.2.4. Papir i karton

Trenutno najzastupljeniji ambalazni materijali. Vazni su u proizvodnji sekundarne i
tercijarne ambalaZe, kutija za skupnu i transportnu ambalazu. Sto se ti¢e primarne ambalaze,
papir, pa Cak i karton se koristi za pakiranje proizvoda nize vrijednosti. Valoviti karton je
izuzetno vazan jer se od njega proizvode kutije za transportnu ambalazu, $to je neophodno za
svaki proizvod kako se ne bi oStetio tokom transporta. Danas je zastupljen trend razvoja u
kozmetickoj industriji pod nazivom haptik. Izraz dolazi od grc¢ke rijeci haptika Sto je zapravo
znanost o osjetljivosti koze na dodir. Trenutno je taj trend jako zastupljen, osobito kod
pakiranja visoko kvalitetnih kozmetickih proizvoda kao S§to su parfemi. Prvi takav hapticki
proizvod pojavio se 1999. godine, a bila je to sklopiva kutija za parfem Rochas. Tako karton
na dodir viSe ne djeluje kao karton, nego je mekan, barSunast ili moze imitirati staklo, metale,
itd. (11) Ovakvi materijali mogu se posti¢i tiskom, lakiranjem, laminiranjem. Napretkom
tehnologije, obradom i doradom materijala postizu se vrhunska dostignu¢a u ambalaznoj
industriji.

Primarna kartonska ambalaza osim zanimljivog 1 neobi¢nog izgleda je 1 ekoloski
prihvatljiva. Budu¢i da se papir, odnosno karton moze reciklirati i kompostirati ovakvi

materijali imaju povoljan utjecaj na okolis. (10)

4.2.5. Metali

Za izradu metalne ambalaze upotrebljavaju se crni i bijeli lim, koji su izradeni od Celika.
Razvojem industrije sve viSe tu ulogu zauzima aluminij. Danas postoji trend gdje dizajnerski
dobro izvedene aluminijske kutije sluze kao ambalaza u koju se pohranjuju bocice parfema.
Kutije s tako izvedenim dizajnom, koje imaju na sebi reljef izgledaju luksuzno. Primjer takve
ambalaze pronalazimo kod svjetski poznatog dizajnera Jean Paul Gaultiera.

Ponekad se parfem pakira u metalnu ambalazu vise radi estetskog dojma, nego
funkcionalnog. Manipulacijom metala postizu se raznovrsni oblici i vlastiti izgled postaje
zadtitni znak nekog branda. Razlikovanje medu brandovima postize se dodavanjem
dekorativnih opcija u zavr$noj fazi proizvodnje ambalaze kao §to su mat, sjaj, razna
utiskivanja, itd. Takoder prirodna svojstva metala doprinose njegovoj korisnosti. Oni Stite

proizvod od svjetlosti i oksidacije koji znatno utjecu na rok trajanja proizvoda.
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Jedna od glavnih karakteristika aluminija je Sto je lagan pa omogucava laku upotrebu.
Prednosti metala, to¢nije aluminija, vidljivi su i na ekoloSkom podrucju, buducéi da je aluminij

sklon recikliranju beskona¢no mnogo puta bez da gubi svoja prvenstvena svojstva. (10)

4.3. Podjela ambalaZe prema trajnosti

Vazna podjela ambalaZe s ekoloskoj stajalista dijeli na povratnu i nepovratnu.

4.3.1. Povratna ambalaza

Povratna ambalaza se viSe puta upotrebljava za pakiranje proizvoda, nakon S§to se
upotrijebi ponovno se moze napuniti i upotrijebiti. Povratna ambalaza vraca se proizvodacu
koji ju Cisti, popravlja i ponovno upotrebljava. Najcesce se koristi ambalaza za transport, tj.
kutije, sanduci, ba¢ve itd. Razvojem ekoloSke osvijeStenosti sve viSe se radi na povratu
ambalaze. Ambalaza koju moZemo ponovo iskoristiti pridonosi ocuvanju okolisa. Ponovo se

moze koristiti staklena, plasti¢na, papirnata odnosno kartonska ambalaza.

4.3.2. Nepovratna ambalaza

Nepovratna ambalaza koristi se samo jednom. Nakon upotrebe se uniStava ili ju kupac
koristi u neke druge svrhe. Jo§ uvijek veci dio ambalaze spada u nepovratnu ambalazu i
stvara ekoloski problem. Kako bi se smanjili nepovoljni utjecaji na okoli§ pokuSava se
proizvesti Sto viSe povratne ambalaze. Isto tako radi se na razvoju i upotrebi biorazgradive

ambalaze.

18



4.4. Funkcije ambalaze

Sto se ti¢e ambalaZe, u njene funkcije spadaju zastita samog proizvoda i kvalitete, lakoéa
upotrebe 1 skladiStenje. Ambalaza mora ispunjavati odredene zahtjeve i vrSiti odredene
funkcije prilikom transporta proizvoda i njegove upotrebe. Prilikom odabira ambalaze,

potrebno je razmotriti moguce utjecaje na proizvod, ali i posljedice do kojih moze do¢i.

4.4.1. Zastitna funkcija

Zastitna funkcija je prva 1 glavna funkcija na koju je potrebno obratiti paznju prilikom
proizvodnje i odabira ambalaZe. Prilikom puta robe od proizvodaca do potrosaca ona je
izloZena brojim 1 raznovrsnim utjecajima koji je mogu ostetiti ili u potpunosti unistiti. Zato je
glavna zadaca ambalaze zaStiti robu kako bi ispravna i1 neoSteCena dosSla do potrosaca.
Pravilnim odabirom materijala za izradu ambalaZe, te pravilnom izradom 1 kontroliranim
cjelokupnim procesom omogucuje se isporuka robe potrosacu onakva kakva je i proizvedena.
Ambalaza proizvod mora S§tititi od mehanickih naprezanja i oStec¢enja, kemijskih 1 fizickih
utjecaja, atmosferskih utjecaja, mikroorganizama, gubitka proizvoda i gubitka njenih
sastojaka. U industriji parfema ova funkcija je vazna osobito ako govorimo o skupocjenim
proizvodima. Od vaznosti je saCuvati proizvod onakvim kakav je proizveden. Ukoliko
ambalaza nije podobna za odredeni proizvod moze do¢i do posljedica, ne samo materijalnih,

nego koje mogu biti opasne po ljudsko zdravlje. (12)

4.4.2. Skladi$no - transportna funkcija

Ova funkcija je vazna jer omogucava racionalno koriStenje skladis$nog i transportnog
prostora. Ambalaza oblikom i dimenzijom treba odgovarati i biti prilagodena proizvodu koji
se u nju pakira. Isto kao i1 primarna ambalaza, tako uskladena treba biti i prodajna
(sekundarna) 1 transportna (tercijarna) ambalaZa, a sa svrhom kako bi se pravilno iskoristio
prostor prilikom transporta i skladiStenja. Kako bi se iskoristio najveci dio prostora najbolje je

koristiti kvadratni oblik, dok ostali oblici smanjuju iskoristivost.

4.4.3. Prodajna funkcija

Prodajna funkcija je jako zna€ajna funkcija koju treba posjedovati ambalaza odredenog

proizvoda. Ambalaza ima veliki znacaj u prodaji samog proizvoda jer danas je lakSe

19



proizvesti proizvod nego ga prodati. Ovaj problem nastaje razvojem trzista, konkretno
govoreéi o trziStu parfema. Kako bi prodali svoj proizvod proizvoda¢i moraju nametnuti
proizvod kupcu. Neprestane inovacije i tehnologije doprinose razvoju industrije parfema.
Prodajna funkcija je i marketinska funkcija jer ambalaza nosi veliki broj informacija i
uglavnom je razlog zasto se odluc¢ujemo kupiti neki proizvod. Ova funkcija se najvise odnosi
na primarnu ambalazu, a rjede na transportnu ambalazu. Ova funkcija je dobila svoj znacenje
kada su male trgovine presle na samoposluzni oblik prodajnog centra. Upravo zbog toga
nacina prodaje proizvoda, ambalaZa mora sadrzavati sve potrebne informacije o proizvodu
koje su se nekada mogle dobiti od prodavaca. Ambalaza sada postaje predmet komunikacije
izmedu proizvoda 1 kupca. VeliCina 1 opseg ambalaze takoder utjecu na prodaju proizvoda.

Parfemi i parfemski proizvodi su uglavnom usmjereni na pojedinca. (10) (12)

4.5. Upotrebna funkcija

Ova funkcija se odnosi na koriStenje proizvoda, odnosno ambalaze u kojoj se nalazi
proizvod. Olaksava upotrebu robe, otvaranje proizvoda, pripremu proizvoda za upotrebu i
uzimanje potrebne koli¢ine sadrzaja. Kako bi se proizvod koristio u odredenoj koli¢ini

potrebno je da ambalaza omogucéi to¢no doziranje.
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4.6. Ambalazni oblici u parfemskoj industriji

Oblik ambalaze vazan je element pri kreiranju same ambalaze i njenih daljnjih funkcija.
i prakticnija ambalaza nekog poznatog proizvoda moze potaknuti kupca na kupnju tog
proizvoda. Oblik ambalaze utjeCe na otpornost, nepropusnost, masu, ali i na troskove njena

oblikovanja i proizvodnje.
4.6.1. Kutije

Kutije su neizostavan ambalazni oblik u parfemskoj industriji. Ne samo kao transportna i
skupna ambalaza, nego 1 kao prodajna ambalaza. Svaki parfem pohranjuje se u kutiju.
Nacinjene su od raznih materijala, naj¢eS¢e od kartona, valovitog kartona, metala, plastike.
Prodajne kutije u koju su upakirani parfemi i parfemski proizvodi, zapravo su ambalaza koju

kupac vidi pri kupovini. (10)
4.6.2. Boce

Boce su neophodne u industriji parfema. Namijenjene proizvodima tekuéeg stanja.
Volumen boca varira, a §to se ti¢e parfema i parfemskih proizvoda, boce su napravljene u
mililitarskom volumenu. Materijali od kojih su izradeni su uglavnom staklo, plastika i metal.
Staklene boce su najprikladnije za pakiranje parfema jer potroSaci na parfeme gledaju kao na
luksuzne proizvode, a staklo nam daje dojam luksuza. Parfemi ili parfemski proizvod rjede
mogu biti pakiran u plasti¢nu bocicu. No sve ovisi o prakticnosti te boce jer svaki proizvod
zahtjeva odreden oblik koji odgovara sadrzaju. Boce izradene od metala koriste se najvise za
pakiranje komprimiranih i ukapljenih plinova. Sluze kao ambalaza za aerosole, tj. proizvode
koji se mogu Kkoristiti u disperziranom stanju, ali se koriste i kao vanjski omot — kuciste za

staklenu bocicu, tj. parfem se nalazi u staklenoj bocici koja je omotana metalnim slojem. (10)
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4.7. Dizajn ambalaze

Pod elemente dizajna ambalaze ubrajaju se boje, slikovne i tekstualne informacije. Oni
kod potrosaca stvaraju misljenje i formiranje stava o proizvodu. Kombinacija elemenata
zapravo 1 ¢ini ambalazu takvom kakva jest. U industriji parfema imaju vazan utjecaj jer

ambalaza je Cesto ono §to kupac kupuje i ona stvara cjelokupni dojam proizvoda.
4.7.1. Boje

Boja je jedan od vaznijih ¢imbenika koji privla¢i kupca. Boje stvaraju psihicki dozivljaj
kod ljudi, pokreéuci osjecaje i stvaraju¢i pozitivne ili negativne misli. Boja prenosi
informacije o proizvodu, njegovoj namjeni i kvaliteti. Kombinacija boja stvara stav kupca o
proizvodu prije nego ga proba. Pri dizajnu ambalaze vrlo je vazno razmisliti 0 bojama koje
¢emo upotrijebiti. Treba poznavati psihologiju boja kako bi mogli shvatiti §to kupac Zeli
vidjeti na policama prodajnih centara i koju poruku bi proizvod, odnosno ambalaza trebala
prenijeti. Boja je Cesto zastitni znak nekog branda kao $to je slucaj Old Spice kozmetike s
kojom povezujemo crvenu boju. Na ambalazi parfemskih proizvoda danas moZemo pronaci

bas sve vrste i nijanse boja. (10) (13)
4.7.2. Slikovne informacije

Vazan ¢imbenik u dizajnu ambalaze. Obuhvaca ilustracije, vizualne oblike ili sliku samog
proizvoda. Izbor slikovne informacije je osobni odabir dizajnera. Proizvod najbolje
predstavlja slika koja je otisnuta u ambalaZi jer nam govori §to se unutra nalazi. Cesto se na
ambalazu aplicira i slikovna informacija sirovine od kojeg je proizvod nac¢injen. Kod parfema

slika cvijeta uglavnom govori kakav je miris.
4.7.3. Tekstualne informacije

Element koji se nalazi na svakoj prodajnoj ambalazi pa tako i na ambalazi parfema i
parfemskih proizvoda. On nam daje informaciju kao $to su proizvodaé¢, upute o sastavu i
upotrebi proizvoda, koli¢ini itd. Vecina kupaca ne obraca paznju na ove pokazatelje jer oni
nisu uocljivi kao slikovne informacije tj. pokazatelji. Tekstualne informacije zahtijevaju
Citanje 1 razumijevanje otisnutog teksta, ali upravo one konkretno govore o kakvom je

proizvodu rijec.
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4.8. Vrste parfema

4.8.1. Cyvjetni

Najveca mirisna grupa koja uklju¢uje mnostvo varijanti kompozicija s cvjetnim srcem:
svjeze ubrano cvijece, cvije¢e s vodenim, zelenim ili puderastim nijansama, kao i cvjetno
aldehidne, cvjetno vo¢ne i gurmanske kompozicije. Vecina cvjetnih mirisa namijenjena je

zenama jer odiSe Zenstvenosc¢u i snagom. (14)
4.8.2. Orijentalni

Orijent, je rije¢ koja miriSe na zaCine, znacajna drva, udaljenosti i tajne. Orijentalni mirisi
dobivaju novu popularnost u ovo doba i parfumerije nude cijelu paletu ovih parfema, od
laganih cvjetnih orijentalnih za obi¢ne ljude ili snaZne uljne parfeme izravno iz arapskih
zemalja.

Za orijentalne parfeme su tipicni sastojci:

e zacini (cimet, vanilija, kardamom, ponekada i kumin)
e drvo (sandalovo, cedro, ruzino, agar)

e 0sebujno cvijece ili aromaticno bilje

Dominiraju topli 1 senzualni amber, moSus i vanilija, a orijentalni se mirisi slazu s

cvjetnim i zac¢inima. (15)
4.8.3. Citrusni

Citrusna grupa mirisa je stara i blagorodna, kompozicije su zasnovane na citrusnim
notama limuna, narance, bergamota, grejpfruta ili mandarine, uz druge citrusne, aromati¢ne
oStre note za muske ili cvjetne note za zenske mirise.

Citrusi se slazu s osjetljivom i vedrom Zenskom prirodom. Zene koje vole citrusne mirise

optimisti¢ne su i otvorene. (16) (17) (18)
4.8.4. Chypre

Ova grupa je dobila naziv po parfemu Coty Chypre koji je bio kreiran 1917. Chypre na
francuskom znaci kipar. Ostri sofisticirani miris je zasnovan na harmoniji hrastove mahovine,
labdanuma, paculija i bergamota.

Slazu se s citrusnim gornjim notama, cvjetnom sredinom i mahovinastom ili moSusnom

bazom. (17)
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4.8.5. Drveni

Kompoziciju drvenih nota u srcu parfema naglaSavaju note drvene baze. To su
sandalovina, su$i i oStriji cedar i vetiver i smolaste balzamicne egzotine vrste. Prate ih
aromati¢ne 1 citrusne note.Ovi su mirisi prirodni 1 blagi, no istovremeno pruzZaju osjecaj

svjezine i neovisnosti. Muskarci ih vole jednako kao i Zene. (17) (18)
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4.9. Vrste mirisa u skladu s koncentracijom mirisnog ulja

4.9.1. Parfimirana voda

Miris traje manje od sata. Ovo je najrazrjedenija vrsta mirisa, uglavnom sadrzi od jedan do

tri posto parfemskog ulja u alkoholu i vodi. (19)
4.9.2. Kolonjska voda

Miris traje oko dva sata. To je najstariji izraz za parfem, koriSten u Sjevernoj Americi za

muske mirise. Obi¢no ima od dva do Cetiri posto parfemskih ulja u alkoholu i vodi. (19)
4.9.3. Toaletna voda

Miris traje oko tri sata. To je lagana mjeSavina u spreju, koja sadrzi od pet do petnaest

posto mirisnog ulja rastvorenog u alkoholu. (19)
4.9.4. Eau de parfum

Miris traje od pet do osam sati. Koristi se kao oznaka i za muske i za zenske mirise, a

sadrzi od 15 do 20 posto Cistog parfemskog ulja. (19)
4.9.5. Parfem

Miris traje do 24 sata. Naziv je dobio od latinskog izraza per fumus (kroz dim). Rije¢ je o
najkoncentriranijem i najskupljem mirisu. Blago masniji, parfem sadrzi od 20 do 30 posto

mirisnog ulja. (19)
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4.10. 10 najpoznatijih svjetskih parfema

4.10.1. ""J'adore", Dior

Moderni, glamurozni parfem nastao 1999. godine. Sladak, ali lagan, blago ostar cvjetni
miris sa svjezinom mandarine u visokoj noti, jasminom, $ljivom, orhidejom i ruzom u srcu te
sa moSusom i kupinom u tragu. Postao je nevjerojatno popularan, zbog ¢ega je dobio nekoliko
svojih varijacija u raznim koncentracijama. Karakteristika parfema je njegova bocica u obliku

grcke amfore. (20)

Slika 4.1 J'adore parfem

4.10.2. ""CK One", Calvin Klein

Jedan od prvih parfema koji je nosio predznak unisex. Parfem "CK One" smatra se
svojevrsnim ¢udom jer iako nije bio vrhunski miris uspio je dobiti kultni status i zadrzati
popularnost 1 u danas$nje vrijeme. Parfema karakterizira svjeZz miris citrusa, a na trziStu se

pojavio 1994. godine. (20)
4.10.3. "Chloé Eau de Parfum", Chloé

Poseban, senzualan i profinjen miris za sve prilike i za sva godi$nja doba. "Chloé" je spoj
cvjetova koji ukljucuju bozur, li¢i i freziju u visokim notama, ruzu, magnoliju i durdicu u srcu

iznad baze od cedrovine i ambera. To je originalni miris koji budi osjecaj klasike. (20)
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4.10.4. ""Chanel No 5", Chanel

Najpoznatiji parfem svih vremena kreirao je Ernest Beaux 1921. godine. "Chanel No 5" je
prvi parfem u cvjetno aldehidnoj grupi i prvi po koli¢ini aldehida u svojoj kompoziciji
(legenda kaze da je asistent Ernesta Beaux greskom stavio previse aldehida). U visokim
notama su aldehidi, bergamot, limun, neroli, ylang-ylang,a u srcu su kompozicije jasmin,

ruza, durdevak, iris, a u bazi su vetiver, sandalovina, vanilija, amber i paculi. (20)

Slika 4.2 Chanel No 5 parfem

4.10.5. ""5th Avenue"', Elizabeth Arden

Parfem nastao 1996. godine naziv je dobio po najpoznatijoj ulici na svijetu koja je olienje
bogatstva i1 luksuza te maste koja se pretvorila u stvarnost. Namijenjen je Zeni sa stilom, koja
je pametna, uspjeSna i elegantna. Gornje note su jorgovan, lipovo cvijece, rosna magnolija,
mandarina, bergamot. U srcu su bugarska ruzicasta ljubi¢ica, ylang-ylang, jasmin, indijska
tuberoza, breskva, karanfil i muskatni orah. Bazu ¢ine amber, tibetski moSus, sandalovina, iris

i vanilija. (20)
4.10.6.""Light Blue", Dolce&Gabanna

Ovaj vrlo popularni ljetni miris lansiran je 2001. godine. Odlikuje ga lezerni miris koji
podsjeca na povjetarac cvjetno vo¢nog mirisa sicilijanskog ljeta. So¢ne 1 vlazne note limete i

Cempresa bude asocijaciju na Sumu na morskoj obali. (20)
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4.10.7. "Classique', Jean Paul Gaultier

Parfem je nastao 1993. godine. Note ruze su u visokim notama, sofisticirana orhideja
dominira ritmovima srca parfema i drvenih akorda, dok vanilija djeluje u donjim notama
parfema. Atraktivna je i ambalaza parfema - bocCica u obliku Zenskoga tijela odjevena u

¢ipkanu haljinu u zla¢anoj metalnoj ambalazi. (20)

Slika 4.3 Classique parfem

4.10.8. ""Opium', Yves Saint Laurent

Cetvrti najpopularniji parfem svih vremena. Orijentalnu za¢insku harmoniju ovog
provokativnog i opojnog mirisa ¢ine mandarina, jasmin, karanfil i vanilija. Parfem je izazivao
kontroverze zbog svog imena koje je razljutilo Kineze koji Zive u SAD-u. Trazili su da im se
Laurent, koji je ime smislio sam, isprica zbog nepostivanja kineske povijesti i problema
izmedu Kine 1 SAD-a 1 da pronade drugo ime. Sve je rezultiralo time da je "Opium" postao

jedan od najprodavanijih parfema u povijesti. (20)

OPIUM

=

Slika 4.4 Opium parfem
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4.10.9.""L'eau d'Issey"’, Issey Miyake

Parfem u sebi objedinjava hladne kapljice vodopada, aromu cvije¢a i mirise proljetne
Sume. "L'eau d'Issey"” je cvjetno vodeni miris sa prozraénim notama lotusa, frezije, ciklame i
so¢ne dinje. Srednje note bozura, durdevka i karanfila otkrivaju karakter parfema. Zavr$na

bazna nota je elegantna drvena s cedrovinom, sandalovinom, mosusom i amberom. Parfem je

kreiran 1992. godine. (20)

4.10.10. 'Shalimar', Guerlain

Jedan od najprodavanijih parfema na svijetu nastao je 1925. godine inspiriran ljubavnom
pricom Saha Shahjahana i njegove Zene Mumtaz Mahal. Nakon smrti svoje voljene supruge
Sah je podigao ¢uveni Taj Mahal u njezinu Cast kao simbol njihove ljubavi. Miris ukljucuje
note limuna, bergamota, jasmina, majske ruze, opoponaksa, boba Tonka, vanilije, irisa,
tamjana 1 sivog ambera. Kratki hlad citrusa vodi u bogato cvjetno srce s raskoSnom finalnom

toplinom. (20)
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5. Vlastita ambalaza parfema

File Edit Object Type Select Efect View Window Help
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Slika 5.1 Sudelje Tllustratora

Nakon pokretanja Adobe Illustratora otvara se radno sucelje programa.

File Edit Object Type Select Effect View Window Help Essentials v .

NN& Py
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Untitled-2

Millimeters

pRIQOAN MY

Jel
>

@,
=,
K1
B,
O

ne® o0l

23
d
)
=]
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Fee

CMYK Color

More Settings

Slika 5.2 Dizajn korak 1

Novi dokument otvorimo preko Izbornika File > New. Postavke postavimo po vlastitoj
zelji 1 potrebi ili ve¢ predlozenim na¢inima. Za izradu ambalaze potrebno je odabrati opciju za

tisak te A3 leze¢i format i kreiramo dokument tipkom Create.
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Slika 5.3 Dizajn korak 2

Otvorio se prazan dokument.

File Edit ype  Select e Help B = %4

[ = o — B - BN

Parfemska ambalaza* ® 63% (CMYK/Preview) X

] Rounded Rectangle Tool
Ellipse Tool
Polygon Tool
Star Tool
Flare Tool

DROAN Ny

Rectangle

Slika 5.4 Dizajn korak 3

Odaberemo alat Rectangle Tool pomocu kojeg napravimo pravokutnik.
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File Edit t Transform >

Rectangle D -

Arrange >
Group Cil+G

Ungroup ShiftsCtrl+G
Lock >

Parfemska amb)

Unlock All Alt+Ctrl+2
Hide >
Show All Alt+Ctrl+3

Expand...
Expand Appearance
Crop Image

Resterize...

Create Gradient Mesh...
Create Object Mosaic...
Create Tiim Marks
Flatten Transparency...

Make Pixel Perfect

Slice »

Path B Join Cirle)
Shape > Average.. Al Carle)
Fattern ’ Outline Stroke
Blend ’ Offset Path...
Envelope Distort ’ Reverse Path Direction
Perspective >
Live Paint > Simpliy..
Add Anchor Points
Image Trace »
S — s Remove Anchor Paints
Line and Sketch Art > O s

Clipping Masle N Split Into Grid...
Compound Path > Clean Up...

Artboards >

Slika 5.5 Dizajn korak 4

Novonastali pravokutnik podijelimo na razne dijelove tako da odaberemo opciju Object >
Path > Split Into Grid.

0]
e - opecty: 0% > sy [l @€ I = I8 1)1 Tendom of v

Parfemska ambalaza* @ §9% (CMYK/Preview) X
¢ Colar

L' |
———

Split Into Gridl

Columns
Num|

width: |

[ Add Guides

[ preview

Slika 5.6 Dizajn korak 5

Postavimo opcije prema prikazanim vrijednostima kako bi dobili elemente kojima mozemo

dalje manipulirati.
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e Edit Object Type Select Effect View v Help SN o

(] B~ soe= 2 Qe 100% B It e Hd W e o v 25

Parfemska ambalaza® @ 69% (CMYK/Preview) X
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Slika 5.7 Dizajn korak 6

Odaberemo pravokutnike kao na slici pomocu tipke Shift + Click na pravokutnik.

Essentials +

O~ &~

Parfemska ambalaza* @ 69% (CMVK/Preview) X

Slika 5.8 Dizajn korak 7

Pravokutnike izbriSemo tipkom Delete na tipkovnici.
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File Edit Object Type ct  Effect w - Essentials B
Color Guide Shift+ F3
[~ B~ sow T © eI LLIEN D 2

Parfemska ambalaza® @ 69% (CMYK/Preview) X CS5 Properties
Document Info

Flattener Preview

Gradient Ctrl+Fo
Graphic Styles Shift+F5
Image Trace

Info Ctrl+FE
Layers F7
Learn

Libraries

Links

Magic Wand

Navigator

Pathfinder Shifts Ctrl+ F

Pattem Options

Separations Preview

Stroke Ctrl+F10
SVG Interactivity

Swatches

Symbols Shift+Ctrl+F11
Transform Shift+F8
Transparency Shift+ Ctrl+F10
Type »
Varizbles

Brush Libraries
Graphic Style Libraries

Swatch Libraries

Symbol Libraries

~  Parfemska ambalaza® @ 69% (CMYK/Preview)...

Slika 5.9 Dizajn korak 8

Za jednako smanjenje pravokutnika u paleti 1zbornik odaberemo Window > Transform.

File Edit Object Type . Help = 9

[~ B~ st C - e~ opacity: 0% > s [l ~

Parfemska ambalaza* @ 69% (CMVK/Preview) X

Transform

DREAM MY

FEFTHINNS DY

Slika 5.10 Dizajn korak 9

Oznac¢imo zadnji red pravokutnika te ith smanjimo za duplo. Isto napravimo 1 sa prvim redom

pravokutnika.
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File Edit Object Type ct  Effect Help | I ) Essentials ~  P.
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Parfemska ambalaza® @ 69% (CMYK/Preview) X

Slika 5.11 Dizajn korak 10

Nakon prvog smanjenja, smanjimo odredene elemente jos$ jedanput.

File Edit Object Type . Help = 9 Essentials o,

[~ B~ st C - e~ opacity: 0% > s [l ~

Parfemska ambalaza* @ 69% (CMVK/Preview) X

Transform

FEFTHINNS DY

Slika 5.12 Dizajn korak 11
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Parfemska ambalaza® (CMYK/Preview) X
Y

) Group Selection Tool

v

7
s
T,
=

Slika 5.13 Dizajn korak 12

Pomoc¢u Direct Selection Tool alatom mozemo odabrati samo jedan kraj pojedinog elementa

kojega zatim smanjimo kako bi dobili dijelove ambalaze.

e Edit Object Type Select ect  View Help =~ 9
- K . ———— .
- v g Pl - orecty: 0% 3 sy [l v pocumentsetup || Preferences | BE v

Parfemska ambalaza* @ (CMYI/Preview) X

2 2 of 24 - Clipboard
Item not Collected: Delete items
to increase available space

Slika 5.14 Dizajn korak 13
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Help | Essentials ~ oo

v Opacity: 100% > zmle:.v @

Slika 5.15 Dizajn korak 14

Pravokutnik koji ¢e sluziti kao dno odnosno poklopac ambalaze kopiramo.

File Edit C cf ct View v Help B A Essentials » 0.

[~ Bi~ s [—— . P

Parfemska ambalaza* @ §9% (CMYK/Preview) X

DROHw v T

Transform

Slika 5.16 Dizajn korak 15

Postavimo vrijednosti prikazane na slici.
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File

Transform

Slika 5.17 Dizajn korak 16

File Edit Object S \ \ v
PO ool lutiifect  SnifteColsf . . "
L]y By s © Last Effect PRUERSHP = - or-cir: 1% = - e

L EEEL RS R CY Document Raster Effects Scttings...

lllustrator Effects

kv

Convert to Shape

Crop Marks.

Distort & Transform

Path

Pathfinder
b Transform
S Drop Shadow...
SVG Filters

Warp Feather...

Inner Glow..
Photoshop Effects

Effect Gallery...
Atistic Round Comers...

G Scribble...
Brush Strokes

Quter Glow..,

Distort
Pixelate
Sketch
Stylize
Texture
Video

Slika 5.18 Dizajn korak 17

ProduZecima trebamo zaobliti rubove tako da u lzborniku odaberemo Effect > Stylize >

Round Corners.
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Help | Essentials ~ oo
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Parfemska ambalaza® @ 69% (CMYK/Preview) X

Transform

Round Comers

Radius: | 2

— R
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Slika 5.19 Dizajn korak 18

Postavimo radijus na 1 cm i kliknemo OK.

File Edit C c ct View v Help =~ G

W Wi e [ —— oo AP

Parfemska ambalaza* @ 69% (CMVK/Preview) X

Transform

Line Segment

Slika 5.20 Dizajn korak 19

Da bi razdvojili pravokutnik na 2 jednaka dijela povuemo liniju na sredini pravokutnika

pomocu Line Segment Tool-om.
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File Edit Object Typ
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Slika 5.21 Dizajn korak 20

File Edit Object Transform | ()

= B T . opaie o > e [l @

Parfemska amb

Group Ctri+G
Ungroup ShiftCtrls G
Lock
Unlock All Al Crl+2
Hide
Show All AltsCrl+3

Expand...
Expand Appearance pathfinder
Crop Image

Shape Modes:
Rasterize..

=
Create Gradient Mesh... B0 & O

Create Object Mosaic... Pathfinders:

Create Trim Marks m W W O® E @
Fiatten Transparency..
Make Pixel Perfect

Slice

Path
Shape

Pattem

Blend

Envelope Distort
Perspective

Live Paint

Image Trace

Text Wrap

Line and Sketch Art

Clipping Mask
Compound Path
Artboards

Slika 5.22 Dizajn korak 21

Oznacdimo pravokutnike sa linijjama te ih naredbom Object > Expand Appearance prosirimo

odnosno omoguc¢imo podjelu jednog objekta (pravokutnika) na vise objekata koji ¢ine cjelinu.

40



File Edit C ¥ . Help |
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Parfemska ambalaza® @ 69% (CMYK/Preview) X

Pathfinder

Slika 5.23 Dizajn korak 22

Kako bi podijelili oblik na dijelove otvorimo Window > Pathfinder > Divide.

File Edit C f ct View v Help 0= v Gy Essenfials » O,

(] B~ e 2 [ —— oo AP

Parfemska ambalaza* @ 69% (CMVK/Preview) X

Undo Ungroup Pathfinder

Redo
Make Pixel Perfect
Perspective

Crop Image
Isolate Selected Group
Ungroup

Transform

Arrange

Select
Add to Library

Collect For Export
Export Selection...

Slika 5.24 Dizajn korak 23

Elementi su grupirani pa ih je potrebno razdvojiti pomo¢u desnog klika na element >

Ungroup.
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File Edit Object Type Select Effec Essentials

]~ B~ swe - B~ cowmentsetup || Preferences | HE v
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2

7
s
T,
=

Slika 5.25 Dizajn korak 24

Visak elemenata obriSemo tipkom Delete i spojimo krajeve na ambalazu.

e Select Effect Essentials

Parfemska ambalaza* @ 69% (CMVK/Preview) X

Slika 5.26 Dizajn korak 25

Oznadimo cijelu ambalazu te stavimo crni okvir i postavimo bez ispunjenja boje zbog

lakSeg daljnjeg uredivanja.
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Slika 5.27 Dizajn korak 26

Otvorimo sucelje Photoshop-a i po¢nemo uredivati. Obojimo dijelove koji ¢e se preklapati
te ostavimo glavne stranice prazne radi lakSeg uredivanja u Photoshop-u. Gotov okvir

ambalaze spremimo u Illustratoru kako bi mogli prenijeti u Photoshop i nastavili uredivati.

Help

@ Fowm w00% [ (f ¥ signed sample

e
64
E S
e ]
Adjustments
Add an adjustment

Slika 5.28 Dizajn korak 27

Otvorimo sucelje Photoshop-a.
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File Edit Image Layer T Filter
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Slika 5.29 Dizajn korak 28

Stavimo iste postavke novog dokumenta kao Sto smo napravili u lllstratoru.
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Slika 5.30 Dizajn korak 29

Otvori nam se prazan dokument na kojega ¢emo prenijeti ambalazu iz Illustratora.
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Slika 5.31 Dizajn korak 30

Prije otvaranja ambalaZe otvorimo sliku kojom ¢emo urediti ambalazu.

PS File Edit Image Layer Type et Filter

| S Auto-Select:  Group 3 Show Transform Controls

Parfemska ambalaza @ 25% (Layer 6, RGB/8) * x

b
&

Adjustments
Add an adjustment
00wk 56 P9
HI2ES O H
HEEXMDE

Layers
Hkind & o T 114

Normal = Opacity: 100%

lock: B & & @ Fl 100% [T
. Tl
L]

Layer 6

e,
LK
7,
;-"‘
4,
4"‘
E
=,
& >
m
'
o,
"
T §
k..
m
.
Q

[
e

B ]

Doc: 43,80/33,0M

Slika 5.32 Dizajn korak 31

Na postojecu ambalazu dodamo sliku cvijeca po Zelji.
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Gradient Editor m] X
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Slika 5.33 Dizajn korak 32

Pomocu Gradiant Tool alata slozimo boje koje Zelimo da se protezu po odredenom objektu.
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Slika 5.34 Dizajn korak 33

Oznacimo objekt koji Zelimo te preko njega povu¢emo Gradiant kako bi dobili Zeljeni efekt

tj. prekrivanje u paleti Layers odaberemo Overlay prekrivanje.
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Slika 5.35 Dizajn korak 34
Stavimo odredene znakove koje treba sadrzavati parfemska ambalaza.
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Slika 5.36 Dizajn korak 35

Pomno odabrano pismo teksta stavimo na prvu stranu koje odmah mora privuéi paznju

kupca.
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PS File Edit Image Layer Type Select Filter View Window Help
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Slika 5.37 Dizajn korak 36

Ambalaza mora sadrzavati osnovne podatke o parfemu kao $to su vrsta parfemskog
proizvoda, sastojci, odakle parfem potjece itd. Kada smo sve parametre ispuniti za dobru

ambalazu te smo zadovoljni dizajnom spremimo dokument i pripremimo ga za tisak.

Bouquet

Slika 5.38 Gotova ambalaza parfema
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6. Zakljucak

Mirisi 1 parfemi su od davnina privlacili paznju ljudi i postali vazan dio svakodnevnog
zivota. Ljudi su kroz stoljeca isprobavali razne nacine dobivanja mirisa. S vremenom se od
toga razvila vrlo uspjesna parfemska industrija. S pojavom velikog broja parfema i
parfemskih proizvoda, bilo je potrebno obratiti veliku paznju na sam izgled bocica parfema
kako bi se Sto bolje mogao prodati proizvod. Tako je dizajn ambalaze parfema dosao do svog
razvoja. Pocelo se voditi racuna o svim detaljima, od samog izgleda bocice, boja koje se
koriste do materijala od kojih se izraduje ambalaza.

Vanjski izgled 1 prvi dojam svakako su najvazniji jer utjecu na odluku kupca da kupi
proizvod koji mu privu€e paznju. Pri dizajnu vrlo vaznu ulogu igraju boje koje pravilnim
odabirom 1 kombinacijom boja privlace paznju kupca i postaju prepoznatljivi za odredene
parfeme. Potrebno je obratiti paznju kakav proizvod imamo i1 kome ga Zelimo prodati. Isto
tako treba voditi raCuna o kvaliteti ambalaze koja se koristi za odredeni proizvod kako bi se
proizvod =zastitio od vanjskih utjecaja i saCuvao svoju kvalitetu.. Isto tako postoje parfemi
koji su obiljezili povijest parfema i ostali do danas zapamceni, Sto zbog kvalitete mirisa, Sto
zbog prepoznatljivog, ponekad jednostavnog, ali vrlo dojmljivog dizajna. Moze se sa

sigurno$c¢u reci da pravi dizajn utjee na odluku kupca da kupi odredeni proizvod.
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SVEUCILISTE
SIEVER

1ZJAVA O AUTORSTVU
I
SUGLASNOST ZA JAVNU OBJAVU

Zavréni/diplomski rad iskljuéivo je autorsko djelo studenta koji je isti izradio te student
odgovara za istinitost, izvornost i ispravnost teksta rada. U radu se ne smiju koristiti
dijelovi tudih radova (knjiga, élanaka, doktorskih disertacija, magistarskih radova, izvora s
interneta, i drugih izvora) bez navodenja izvora i autora navedenih radova. Svi dijelovi
tudih radova moraju biti pravilno navedeni i citirani. Dijelovi tudih radova koji nisu
pravilno citirani, smatraju se plagijatom, odnosno nezakonitim prisvajanjem tudeg
znanstvenog ili struénoga rada. Sukladno navedenom studenti su duZni potpisati izjavu o
autorstvu rada.

b
Ja, _2ubliun Cestor (ime i prezime) pod punom moralnom,
materijalnom i kaznenom odgovornoséu, izjavljujem da sam iskljucivi
autor/ica zavrinog/diplomskog (obrisati nepotrebno) rada pod naslovom

fkico. '\”\\‘L A \xmﬁ(nms\vL st (upisati naslov) te da u
navedenom radu nisu na nedozvol)em naéin (bez pravilnog citiranja) koristeni
dijelovi tudih radova.

Student/ica:

(upisati ime i prezime)

zz)Jd( wo. (Esfof

(vlastoruéni potpis)

Sukladno Zakonu o znanstvenoj djelatnost i visokom obrazovanju zavrsne/diplomske
radove sveudilista su duzna trajno objaviti na javnoj internetskoj bazi sveudili$ne knjiznice
u sastavu sveudilifta te kopirati u javnu internetsku bazu zavr$nih/diplomskih radova
Nacionalne i sveuéilisne knjiznice. Zavr3ni radovi istovrsnih umjetnickih studija koji se
realiziraju kroz umjetni¢ka ostvarenja objavljuju se na odgovarajuci na¢in.

Ja, Zaul'w (ertay (ime i prezime) neopozivo izjavljujem da
sam suglasan/na s )avx}gm objavom zavr3n Eﬁ/dlplomskog (obrisati nepotrebno)
rada pod naslovom _Iabivanyo _u poodkwnShy ndestng, (upisati
naslov) ¢iji sam autor/ica. v

Student/ica:
(upisati ime i prezime)

Dol Ceshsy
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